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New in Version 1.4

Clean & ISO Recording

. Record up to 4 sources simultaneously - choose from “clean” (without graphics) and
“dirty” (with graphics) program as well any live camera inputs.
. Support for time of day timecode in recorder and media player.

For More Information on ISO Recording:
http://help.livestream.com/customer/portal/articles/1348317-iso-recording-best-practice-
recommendation

Media Playback while Recording
. You can now open your recordings in the media player without the need to stop the
recording - allowing you to perform some basic replay workflow.

Remote Camera

. Desktop - Broadcast a remote computer desktop video and audio as a Livestream
Studio input via your local Wifi or Ethernet network. Supports full motion and audio.
Requires installing Livestream Studio Remote Camera on the transmitting computer
(Available for Windows only, Apple OSX coming soon).

. Cloud - Downlink live feeds from your Livestream accounts and use it as a remote live
source in your program mix.

For More Information on Remote Camera:
http://help.livestream.com/customer/portal/articles/1263047-livestream-studio-remote-camera

Minor User Interface Updates
. New Tab design which make it easier to see which tab is selected and shown.

Audio Pre-Mixer Upgrade
. Now you can map multiple audio channels to left and right in the pre-mixer, allowing

you to perform a pre-mix in stereo mode.

Various Bug Fixes
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1. Getting started

1.1 Welcome to Livestream Studio™

Congratulations and welcome to Livestream Studio™. All hardware products
come with Livestream Studio™ preinstalled. It just takes a few steps to combine Live
HD sources, two media players, two graphic overlays and two color generators
into a broadcast quality production, whether for large-format screens or

streamed to an audience online using the built-in encoder.

This manual applies to the Livestream Studio™ Software as well as the
Livestream Studio™ HD50, HD500, HD900 and HD1700.

Livestream Studio™ can:

e Mix multiple video inputs with two channels of internal Media Player, two

channels of GFXoverlaysand two color generators.

e Stream HD video to the Livestream platform via Livestream Studio™’s built in

encoder.

e Output a broadcast quality PGM line cut on a variety of digital and analog

connectors.
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1.2 Installing Livestream Studio™

Note: Blackmagic Desktop Video drivers must be updated to version 9.6 or higher for
use with Livestream Studio™ v1.2 or higher. Go to blackmagicdesign.com/support to

update drivers.

A USB dongle comes pre-installed on
Livestream Studio™ Hardware. For
Studio Software™ only users, make
sure to start by inserting the dongle

and opening the drive. Double click

the Livestream Studio™ Launcher.

|| e

Agree to the Terms of Service and click [EEEEERETTEEIT
End-User License Agreement

“ ”
Next. Please read the following license agreement carefully

END USER LICENSE AGREEMENT

1. Introduction and Acceptance. BEFORE DOWNLOADING OR
USING THE SOFTWARE MADE AVAILABLE IN BINARY FORM ON THIS
PAGE (the "Software"), YOU ("you”, or the "User”) MUST READ AND
[AGREE TO THE TERMS OF THIS END USER LICENSE AGREEMENT, AS
IMODIFIED FROM TIME TO TIME BY LIVESTREANM (the “agreement”).
IF YOU DO NOT READ AND AGREE TO THE TERMS OF THIS

eam Studio Launcher Setup —:]

Follow the steps to complete

Completing the Livestream
Studio Launcher Setup Wizard

installation and click finish.

Click the "Finish" button to exit the Setup Wizard.
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After clicking finish, a second installer will launch.

i

Mlivestream studio

Click ‘Install,” accept the terms, and follow the steps to completion. This second

process will look exactly like the first. Once complete, Livestream Studio™ will launch.
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2. User Interface Overview

The Livestream Studio software will launch to the main operating Ul.

Stream Button

Streaming Info Pane

Record Button

CPU Usage Monitor

Preview Window

Program Window

Main Mix Window / InsertAdvertising
GFX Overlay Window

Multiview

Audio Mixer

000000060000

Modules (Input Settings, Streaming, Media Editor, Graphics, and Wipes)
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Note: Audio mixer, Input Settings, GFX, Media, and Streaming modules can be
moved freely between left and right side windows by dragging and dropping tabs

to the desired window.
3. Physical Connections

3.1 Blackmagic Video Card Input/Output

Livestream Studio™ only works with Blackmagic Design® products.

This ensures that our product is extremely reliable and robust since we do not need
to test and integrate multiple cards from various vendors. Blackmagic also offers a
variety of high quality products at very affordable prices.

For a list of supported devices please see Appendix A.

Each Livestream Studio™ hardware product comes with a connection diagramin the
box.

3.2 Graphics Card Input/Output (Multi-Screen)

Starting with Studio™ V1.3, the software can support anywhere from 1 to 4 displays, allowing
for various viewing configurations across all of the available screens. (More on this in section
4.5: Multi-Screen)

Note: In order to utilize 4 screens, we recommend purchasing a Quad GPU graphics card such
as the NVidia Quadro series cards.

Settings

General

Input / Output

Recording 1. NVIDIA GeForce GTX 470 (VA2448 SERIES) IDENTIFY

Streaming
1920x1080

Multi-Screen

Ad Insertion

Hotkeys

Support

About
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4. Preferences

Before using Livestream Studio™, it is necessary to configure the project settings. To
begin configuration, click the “Gear Wheel” icon in the top right-hand corner of the

ul.

5% CPU 12:34:21 AM

Note: Preferences are locked when streaming is in progress. Be sure to set all

preferences before taking a stream live.

4.1 General Preferences

Settings

General
Project Video Format
Input / Output

Recording Project Audio Format 43

Streaming
Multi-Screen Deinterlacing
Meth

AdInsertion Crossfade Audio on Cut 5 Frames
Hotkeys
Media Autoplay *  Pause playback

Support

About ®  Continue playback

Transcoding Cache

Startup @ Launch on startup

Disable Windows Aero Theme
on Start

Other  Low Input to Output Latency (Beta)
Tally Lights

@ Send Diagnostic and Usage Data to
Livestream

Video Format: Defines the primary project format for Livestream Studio™ operation.
Although we recommend setting all cameras to the same format, starting with Livestream
Studio™ 1.3 there is an option to convert the video format of the input. More on this within
the Input Settings section of the manual (5.1). The output format will also match this
selection unless down-conversion is necessary.

Audio Format: Allows selection of mono or stereo audio operation.
Preview Method (Interlaced Operation): Allows selection of multi-view
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interlaced field viewing. This reduces CPU usage when needed.

Preview Method (Progressive Operation): Allows operation in ‘Half Speed Low
CPU’ mode which removes every other frame from multi-view display in order to

minimize CPU usage.

Audio Cross Fade Duration: Sets the speed (in frames) for audio cross fades
following CUT functionality only. Audio cross fades associated with video cross
fades (follow) will follow the ‘Speed’ setting in the ‘Main Mix’ window (see

‘Preview/Program Switching’ section below).

Media Autoplay Mode Behavior: Defines the method for Media Player

playback as ‘Pause Playback’ or ‘Continue Playback.’

Auto Start with Windows: When selected, Livestream Studio™ Software will

launch with Windows.

Different GFX Templates: Allows for different settings and templates between
GFX 1and 2.

Low Input-output Latency Output: This is an experimental beta feature we have

added to reduce latency through the SDI output.

4.2 Input/Output Preferences

Settings

Livestream Studio™ launches with
default settings for (4) HD-SDI inputs
(via DeckLink Quad card) and (1) HD-SDI
output (via DeckLink Studio card). This

Deckd

Inputs and Multiview Configuration

configuration can be changed to
allow for (5) simultaneous inputs with
no live output (streaming or internal
recording assumed in this

configuration). fres

MEDIA2

Output Selection: Selectthe output source first, as this will lock/unlock the
fifth video input accordingly.

HDMI Output ThroughVideo Card: To reduce latencyon the programout,
output directly through the graphics card. Outputting through the Blackmagic

card has varied latency depending on the project format
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by as much as 11 frames. Output through the graphics card does not have sound. It
is only video. This function is ideal for IMAG, like a conference or in venue event,
where the line cut should display on some screens in the venue.

To output through the graphics card go to the Multi-Screen section of the

preferences and configure the external display. More on this in section 4.5.

Note: This function does not work in SD formats (PALand NTSC).

Input Selection: Once the output source is set, make sure the proper input

sources are selected.

Select the desired source from the ‘Video Input’ dropdown for each associated input
channel. Then select the desired audio input method from the ‘Audio Input’ dropdown
for each associated input channel (DeckLink Quad inputs will only support SDI
embedded audio). DeckLink Studio inputs will support embedded, analog or AES/EBU

Audio via the Blackmagic breakout cable.

Note: Blackmagic analog audio input MUST be accompanied by a video input source
to be active. When using analog audio input, be sure to use the DeckLink Studio card

as one of the video inputs.

Configure the inputs so that the multi-view shows only the inputs use to avoid clutter. To
add an input, click the ‘+"icon at the bottom of the settings window. From there
select the type of input source needed: either video sources, graphics, media, or

color bars.

Rename each input channel as it will appear in the multi-view by changing the
associated name under the ‘Camera’ column of the input selection menu. To delete

‘¢

a source, select it and click the ‘-‘icon.
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4.3 Recording Preferences

Record Location: Selects the location where Livestream Studio™ recordings will be

saved. Click the ‘Browse’ button to select the recording location.

Record to Media Bin: When a recording is terminated, it willimmediately be
added to the selected media bin. Both bins can be selected or deselected

simultaneously.

Settings

General

Record Location ~ BROWSE
Input / Output
Recording

Record to Media Bin # Meda 1
Streaming

Multi-Screen

4.4 Streaming Preferences

Settings

Antilag
Input / Output

Recording
Antilag Duration 5000 frames
Streaming

Multi-Screen 2 erva 60 frames

Ad Insertion
Encoder Queue Stop streaming when queue is

Hotkeys 300 frames

Support Bitrate (@ Variable

Constant
About

Other Experimental UDP streaming (beta)

Antilag: When enabled, the antilag feature works to reduce latencyon the viewing
end of the stream; ifadelay on the encoding side builds up past the user selected
‘Antilag Duration’, the frame buffer will be cleared. Generally this option should
remain off unless low latency is a critical component of the broadcast. It should only
be used when a solid internet connection is available for streaming.

Antilag Duration: Defines the antilag duration (in frames) for use with the antilag
streaming feature (see above).

Key Frame Interval: Set the keyframe interval.

Stop Streaming When Encoder Queue Size is reached: Livestream Studio™ will

terminate streaming if the queue limit (set in frames) is reached.

Wlivestream
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Bitrate (Variable vs. Constant): Variable bitrate selection will optimize the encoder’s

bitrate when possible. Selecting ‘Constant bitrate’ will maintain the outgoing bitrate,

regardless of incoming video bitrate.

Experimental
experimental feature for streaming to New Livestream

through ZiXi.

UDP Streaming (Beta):

4.5 Multi-Screen

Settings

General

Input  Output

Recording

1. NVIDIA Ge! v IDENTIFY

This is an

Other @ Experimental UDP streaming (beta)

Slow
*) Fast

Fixed Latency

Disable Primary Multi-view: will disable the multi-
view shown on the Primary display.
Connected Displays: When using multiple external

displays for the output, choose the preferred

display to configure from this drop-down menu.

Streaming

Resolution: Choose from the available resolution

Multi-Screen

Adumsertion settings for the selected display.

Hotkes Frame-rate: Adjusts the frame-rate of the selected

support .
display.
Aoont

Layout: Choose the desired multi-view layout for

cAms Gt x2 MEDIAT  MEDIA2

the selected display or disable the software output

coLort [ /1060 viewers | sTReAM

to that display.
FrostA e Preview: Drag and drop the available input
sources from the above section to the desired spot
on the Multi-View layout.

MEDIAT

Show Audio Levels Overlays: Displays the audio

level overlays on the inputs displayed on the
selected screen.

Show Screen Overlays: Displays on-screen status information on the Multi-Screen.

Show Warning Overlays: Displays status messages on the external display.

Allow Mouse on Multi-View: Disable this option to prevent the mouse from entering the selected

display area.

(CoN

For best results, configure the ‘Multiple Displays’
option within the Screen Resolution section of the

Windows Control Panel to “Extend these displays.”
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4.6 Ad Insertion

This feature allows the producer to insert a Google Advertisement by clicking a
button. Adjust the duration, background and transition type within the “Ad Insertion”

section of the Preferences Menu.

Advertising Insertion

Input / Output

Recording

Streaming

Multi-Screen Segment Duration 30  seconds

Ad Insertion Background Fade to X

Hotkeys Transition CUT

Note: Requires a Google DFP account (http://www.google.com/dfp) and the
purchase of Livestream Platform™ Enterprise Plan.

After configuring the settings, click the ‘Insert Advert’ button below the ‘Main Mix’ section of
the Livestream Studio™ Ul to display a Mid-roll Ad.

4.7 Hotkey Preferences

Set user defined hotkeys for easier Livestream Studio™ operation from the
keyboard.

]

Input / Output
Recording Preview Source 1
Streaming Preview Source 2 2

Multi-Screen Preview Source 3 3

Ad Insertion Preview Source 4

Hotkeys Preview Source 5 5

Support Preview Source 6 6

About Preview Source 7 7

5. Input Settings & The Audio Mixer

Livestream Studio™ accepts up to 8 channels of embedded audio on all digital (SDI
and HDMI) inputs. When a DeckLink Studio card is configured as an input, Livestream
Studio™ can also ingest up to 4 channels of analog audio via 1/4” or 6 channels

AES/EBU audio (analoginputs 3-6 can be used as additional AES inputs when
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analog audio is not in use) via the Blackmagic breakout cable.

Audio mixer control is broken down into three modules: ‘Input Settings’, ‘Converter’ and
‘Audio Mixer.”

5.1 Input Settings

In Livestream Studio™ 1.3 there are three differenttabs within the input settings. The

first one is labeled audio:

Audio Input Settings Module: Two audio channels per input source in stereo mode, or
up to eight audio channels per inputin mono mode, for use with the respective source
fader. By default, channels 1 & 2 are selected for all input sources in stereo mode.

Channellis selected for all input sources in mono mode.

AUDIO MIXER INPUT SETTINGS

INPUT 1 INPUT 2 INPUT 3 INPUT 4 INPUT 5 INPUT 6 INPUT 7

(@ @

To open the input settings module for a given source, click the “Gear Wheel” icon next to
the source’s display name in the multi-view or audio mixer or selectthe desired source

from the ‘Input Settings’ dropdown menu.

Available audio channels are displayed for the selected source. In stereo mode, use the
‘’and R’ buttons along the bottom of the module to assign left and right audio channels
to the input source fader. In mono mode, click the ‘On’ to assign input channels to the

source fader. Each input channel has an individual level meter with gain control.
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Converter: Allows for

AUDIO MIXER INPUT SETTINGS

any form of video input
to be converted to
any type of video Converter
format in real-time.
This allows producers

HD 1080i 59.94
to use different types

of camera sources and formats. The video converter also has an auto detect

function that will recognize different formats instantly.

If the converter does not automatically detect the source format of the
camera, select the ‘Converter’ tab to pick the format from a full range of 1080,
720, NTSC and PAL options and convert it into the format that the current

project is set to.

Also available within the ‘Converter’ tab is the option to ‘Invert Field Order.’
AUDIO MIXER INPUT SETTINGS

[ U]

Converter

HD 1080i 59.94

Tally: Activate and control a Tally Light system through the Livestream Studio™.

AuDioxeR WeUT SETTINGS After connecting the tally system
via USB, designate a specific Tally
Tally Light ; Light to a camera by selecting the

light from the drop-down menu.

5.2 Audio Mixer

Level Meters and Faders: Each input source has a level meter with fader and gain

stage control.

Wlivestream



17

Audio Mixer

#* MEDIA 1

FOLLOW

Peak Hold: To enable peak hold for a particular level meter, click the “Lock” icon

associated with the desired input or master output source.
Air: Pushes the selected input source audio to the master fader.

Follow: Audio transitions will follow video transitions. When selected, Livestream Studio™
will fade between sources based on the ‘Audio cross fade duration’ setting in ‘General
Preferences.’

Link (Input Source Fader): Works in conjunction with the ‘Follow’ setting to group
multiple video inputs to a single audio input. Click the “Link” icon to select the audio
source preferred for each video source.

Link (Stream Out/Record Out Fader): When selected, streaming and recording audio
will follow the same fader. Deselecting this option gives the producer control over
stream out and record out audio faders individually.

Mute: Source faders, as well as master stream and record out faders, can be muted
individually via the mute button.

Audio Monitoring: Audio monitoring is supported through Livestream Studio™’s 1/8”
headphone jack. Individual sources can be solo’d or master audio can be monitored.
To add a source to the audio monitor, click the “Headphone” icon below the desired
audio level meter. Master audio monitor levels can be adjusted via the volume control

in the top right-hand corner of the Ul.

6. Preview/Program Switching

Livestream Studio™ is designed for traditional preview/program switching, with control
available via mouse or user defined keyboard shortcuts. When a source is selected for
preview, it is highlighted in green. When a source is selected for program, it is highlighted

in red.
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6.1 Mouse Control

Left-click on a source to preview it. Right click on a source to take it to program. The mouse
can also control switchingvia the ‘Main Mix’ window. Click the ‘Cut’ button to cut
between previewand program sources. Double clicking the preview window will also
cut it to program. Click the ‘Auto’ buttonto fade or wipe between preview and
program sources; fade time is defined by the ‘Speed’ (in frames) setting in the Main
Mixwindow. The T-bar can also be used to manually fade between preview and

program sources. FTBfades the program to black and also fades audio out.

To select a wipe, go to the wipes module below
which will display an array of wipe transitions.
Adjust the wipe on the right side of the module.
Depending on the complexity of the wipe, the
producer can reverse direction, flip (invert), or
feather each transition. Wipes that work in a
horizontal or vertical manner can be adjusted

according to the X and Y axis.

“Advertising Insertion” can be found within the

‘Main Mix’ section of the Ul. This feature will only

be available to producers with Enterprise Plans

on Livestream.

Note: This feature will only work while streaming to a

Livestream Platform™ Enterprise Plan.

d A IVISIAIS

6.2 Keyboard Control

By default, Livestream Studio™ is set to match the keys on the Studio™ Keyboard.
Reassign the keyboard controls by visiting the “Hotkeys” section of the Preferences

menu.
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7. Streaming

Livestream Studio™ comes with Livestream’s proprietary encoder built in, allowing

for multi-bitrate streaming to the New Livestream platform with the click of a

mouse.

The can also stream to either of the following CDNs:
. Ustream.tv
. Akamai
. YouTube Live
. Zixi
. Wowza Media Server (RTMP)
7.1. Stream to Livestream

7.1.1 Livestream Account Creation

The easiest way to stream to the web = is via Livestream

Platform™. In order to stream through Livestream the user
must first make an account. Go to www.livestream.com. Click
‘Log In" located in the top right corner, and choose ‘Create an
Account’.

Either join via a Facebook account or with an email address.
Once the account is established, the user is free to create

events and broadcast live.

7.1.2 Creating and ManagingEvents

* When is it?

Let your followers know when to
tune in.

Create Event

Create an event to post text, photos,
video and live video.

Start Time Al times in EDT

Enter a name for your Event onsaiz [l
End Time Al times in EDT

| congrorz | (4 15)(10T8)(Puls

Wlivestream

£ Login with Facebook

Posterize

Add a poster to help promote your
event.

To create an event, click on the account name in the top right corner of the

plan and select ‘Create an Event’ from the drop down menu. The user will be

prompted to set the event title (by default the current date), as well as a start

and end time for the event.
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Draft Events - By default, new events will be in draft mode until the user chooses to
Publish & Announce them. Draft events are not displayed publicly on the account
page, but can be broadcasted and viewed while logged into the New Livestream

Producer Account. This is helpful when testing privately.

7.1.3 Log into Livestream

Click on the ‘Stream’ tab to launch the streaming control module. Enter the

username (email) and password to login.

Input Settings Media GFX Stream

Sign Up

Remember me

Create an event within the streaming module or via a web browser. Once the event
has been created, select it from the event dropdown menu. Give the stream a title

and select the streaming quality from the ‘Quality’ dropdown menu.

7.1.4 Quality Selection

Each quality setting has a locked audio and video bitrate associated with it. Quality
selection should be based on available upload bandwidth for streaming. To check
the speed of the connection, go to speedtest.net and run a speed test. Choose the

appropriate streaming profile based on upload bandwidth results.

kevin speirs

kevin

STREAM

Notify Followers and Publish Now
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Mobile Quality:

¢ Video Bitrate = 130-170Kbps, Audio Bitrate=46-48Kbps
e Total A/V Bitrate = 190-200Kbps

¢ Recommended Upload Bandwidth = 0.5Mbps

Normal Quality:

e Video Bitrate = 300-420Kbps, Audio Bitrate=94-96Kbps
e Total A/V Bitrate = 435-455Kbps

¢ Recommended Upload Bandwidth = 1.0Mbps

Medium Quality:

e Video Bitrate = 470-620Kbps, Audio Bitrate=127-128Kbps
e Total A/V Bitrate = 650-678Kbps

¢ Recommended Upload Bandwidth = 1.2Mbps

High Quality:

e Video Bitrate = 1400-1600Kbps, Audio Bitrate=256Kbps
e Total A/V Bitrate = 1750Kbps

¢ Recommended Upload Bandwidth = 2.2Mbps

Medium + Mobile Quality:

¢ Video Bitrate = 600-800, Audio Bitrate=176Kbps
e Total A/V Bitrate = 850-880Kbps

¢ Recommended Upload Bandwidth = 1.3Mbps

High + Medium + Mobile Quality:
e Video Bitrate = 1900-2400Kbps, Audio Bitrate=432Kbps
e Total A/V Bitrate = 2570-2610Kbps
¢ Recommended Upload Bandwidth = 3.0Mbps

HD + Medium + Mobile Quality:
e Video Bitrate = 2500-2900Kbps, Audio Bitrate=430-448Kbps
e Total A/V Bitrate = 3050-3100Kbps
¢ Recommended Upload Bandwidth = 3.5Mbps

HD + High + Medium + Mobile Quality:
e Video Bitrate = 3900-4500Kbps, Audio Bitrate=686-704Kbps
e Total A/V Bitrate = 4586-5204Kbps

¢ Recommended Upload Bandwidth = 6Mbps

Bitrates for Audio in Mono:
e Mobile = 24Kbps
e Normal = 48Kbps
¢ Medium = 64Kbps
e High = 128Kbps
e HD = 256Kbps
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Once quality selection is complete, click the ‘Stream’ button to begin the stream.
Note: Support for multi-bitrate streaming to any CDN (V 1.3 and above) is also
available.

7.1.5 Active Stream

When streaming is active, the Stream Info Window and Streaming Log provide live

updates on streaming status.

Streaming Info Window: Displays live streaming status info.

® STREAM 00:00:01:01 29.97 > 700 Kbps Perfect Streaming

Duration: Displays the current streaming duration.

FPS: Displays the current outgoing FPS.

KBPS: Displays the current outgoing kbps.

Viewers: Displays the number of concurrent viewersconnected to the stream.

Stream Status: Displays the current status of the stream.
Perfect Streaming: The stream is going out with no issues.

Internet Too Slow for Quality: Upload ST

bandwidth does not support selected quality. =
This is generally an on site ITissue and should be
escalated to the IT department. Changing quality
requires the stream to be stopped and
restarted.

Lost Internet Connection: Internetconnection
has been lost. Again, check with onsite ITif this
happens.

CPU Warning: CPU is above 95%.

Streaming Log: Displays live streaming updates.
Antilag Feature Triggered: Antilag has been triggered based on the selected queue

limit (see ‘Streaming Preferences’ above).

Audio Peak Warning: Audio levels are peaking above normal levels.

Press the ‘Stream’ button again to end the stream. When a stream is terminated, the
user willbe prompted to post the clip live to the event feed, save the clip as a draft

on the event page or delete the server recording.

Experimental Streaming Over UDP (Beta): This is a new way to stream to New
Livestream with multiple bit-rates:

Wlivestream
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1. Better channel utilization. Use it fully with 2mb upload connection.

2. The stream goes directly to our data center and does not need a local
publishing point. Streaming over UDP, however, requires a 30% more uplink
bandwidth.

Choose your provider Use Livestream

RTMP Flash Server

Ustream

Custom Zixi Server

7.2 Streamto Other Services

Livestream Studio™ also is built to stream directly to other servicesand platforms.
Services include Original Livestream, Youtube™ Live, Ustream, Wowza, and Akamai.

To stream to another servicejust select the desired platform and log in.

7.3 Stream To RTMP

Streaming in Livestream Studio™ is supported through the FME3.0 plugin. With RTMP
streaming, generate an RTMP URL in order for the encoder to know where to publish the
stream. This URL varies from platform to platform. Before starting, confirm how to generate the

right RTMP URL for the particularuse case.

Once the correct URLis generated, enter it in Livestream Studio™.

RTMP Server

STREAM

OPEN FMLE XML Authorization

Backup Stream

Wlivestream



Give the stream a name and select a quality before going live.

Select an option to authenticate the stream with a Username/ Password by

selecting the authentication box.

Custom RTMP Quality:
Maximum Bitrate: 9999 kbps
Maximum resolution: 1920x1080

7.4 Stream to Custom ZiXi Server
Livestream Studio™ also allows for streaming to a custom ZiXi server. Like RTMP

streaming, a custom ZiXi URL must be generated in order for this feature to work.

Custom Zixi Server

Enter the correct URL into Livestream
Studio™.

Give the stream a name and select a

quality before going live.

Select an option to authenticate the
stream with a UN/PW by selecting the

authentication box.

8. Recording

Livestream Studio™ records local files as Motion JPEG .avi at the selected project
format spec. Recordings are saved in a user selected destination folder (see

‘Recording Preferences’ above). Recorded clips can be imported into the selected

media player automatically once recording has stopped, for instant DVR capability.

Click the ‘Record’ button to begin recording. Click again to end the recording.

Clips recorded locally on Livestream Studio™ are available for immediate use in
Media Players once recordingis terminated. Additionally, clips recorded locally on
Livestream Studio™ are available for immediate use with Blackmagic Media Express,
as well as editing software (Adobe Premiere, FCP, etc.) with the Blackmagiccodec

pack installed.

Wlivestream
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Recording Media: Available recording time is dictated by available internal
disk space. If necessary, an optional SSD expansion bay is available. VisitStore.
Livestream.com for more info.

Additionally, external devices with transfer speeds of at least 50MB/sec may be used
for recording, though performance may vary with external devices—just make sure
the external device is connected and save to that location. Livestream Studio™ also

displays the amount of space remaining on the system hard drive.

Note: Best practices recommendation: when multiple read/write processes are in play
(Media, GFX, recording), it is recommended that multiple media sources/ destinations

be used. This will improve overall performance of the system.

9. GFXChannels

Livestream Studio™ has two built-in GFX overlay channels. When both GFX channels are
active, GFX 2 is overlaid on top of GFX1. Click the ‘GFX 1’ or ‘GFX 2’ tab to access the
corresponding GFX module.

9.1 GFXTemplates

Our graphics generator is built on a template layering system. This allows for
flexibility and makes creating dynamic and beautiful graphics as simple as possible. To
add a template, click the ‘+’ button at the bottom left of the GFX module.

Templates will always be added to both GFX modules. To rename a template,

double click on the display name.

your text here...

Template Design: Launches template

design layout preview window.

Template Data: Launches a view of added data like text or
images.

Wlivestream



Template Background Selection: While working on a template design, choose the
background to work against. Alpha transparency will be maintained regardless of

background selection.

Adding Graphic Components: Once a template has been created, add components to it
such as static and dynamic text, images, and picture in picture.

Text: Text can be added from the graphics _

template and Livestream Studio™ supports fonts o Multi-Line
currently available on the Windows system.
Once text has been added, click the arrow at the . . v
top right-hand corner of the asset within the fOUr text here..

template to adjust font style, size, color, and background color. The ability to adjust the

opacity of the text, background color, Multiline and Auto-Size features are also available.

Multiline: Add text on multiple lines regardless of characters or spacing.
Auto Adjustments:

* Area: automatically adjusts the size of the text box
as text is added or removed. e

* Font: automatically resizes font to reflect the size of
the text box.

Shadow: Adds a drop shadow to the text.

Static Text: Single line of text that never changes.
Dynamic Text: Single line of text that can be altered live
without changing templates. To edit a dynamic text asset
once it has been added:

1. Switch to template ‘data’ view.

2. Click the + button at the bottom of the template to add a dynamic text
line. Rename each line by double clicking on the existing name.

3. To preview a template with dynamic text, click the ‘Eye’ icon associated
with the desired text line. Click the ‘Air’ button to take the template to

Program. Taking a different text line to air will cross fade between the two

lines of text.

Wlivestream
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Countdown: Livestream Studio™ has a built-in countdown with a number of
customizable features. To add a countdown, create a GFX template, click the text
icon and choose “Add Countdown Text.” Acountdown clock will appear; resize and
move the clock like any other GFX layer. To customize the clock, click the “Gear
Wheel” underneath the frame of the clock. A module will open with the following

options:

wEDM STREAM

now tomplate

il S
123:59:31

Countdown to: Counts down to a set time.

Countdown from: Counts down from a set TR

Countdown to

time.
Timer: Counts upward.

Clock: Functions as a clock.

Set the Countdown to either transitionto a
source once completed, disappear, or do

nothing when the countdown has completed.

To format the Countdown, double-click the text
box to see an abbreviation of each available time
field that can be removed or added as needed. The
abbreviations are:

[DD]: Days

[HH]/[H]: Hours

[MM]: Minutes

[SS]: Seconds

[MS]: Milliseconds

[FF]: Frames

Wlivestream

Countdown from

Timer

Clock

COUNTDOWN TO

01

ACTION ON FINISH

e) None

Transition to Source

Hide




Image Assets: Locally hosted PNG (with alpha support) or
JPEG image Assets can be added to a template via the
“Asset Addition” button below the template preview.
Once added, images can be scaled and positioned with
the mouse. Image opacity can also be adjusted by clicking
on the arrow in the top right hand corner of the asset
within the template.

Note: Best practices recommendation: when multiple
read/write processes are in play (Media, GFX, recording), it
is recommended that multiple media
sources/destinations be used. This will improve overall
performance of the system.

Picture in Picture (PiP): To add a PiP, create a new template
by clicking the '+' sign and clicking the camera icon to the right.
Clicking the arrow on the corner of the PiP will display a series of
options which include Source, Opacity, Volume, Shadow, Border
and Resize (Scale / Crop).

Add as many GFX layers as needed, howeverwe recommend VOLUME
keeping the number of PIPs at five or lower.

Dynamic Image: To add a dynamic image click the “Image”
icon and select ‘dynamic image.” Functionality with dynamic
images looks the same as a static image. Dynamicimages,
however, stick to their file location and continually look for
updated files. When a file is updated the image is
immediately updated in the GFX slate. This is particularly
useful for graphics that have minor changes throughout a
program.

GFXTemplate Layering: Asingle GFX template can
support an infinite number of text or image layers. As
assets are imported, they are added to the top layer of
the template. Right-click on the desired image to move it
to another layering position. One Layer Down

To Bottom Layer

Borders and Drop Shadows: In
Livestream Studio™ v1.3, drop shadows
can be added to internal graphics
elements. Borders and drop shadows
may also be added to Picture in Picture.

new template

Copying GFX Templates: Starting with v1.3, move and copy GFX templates by right- clicking
on the template.

Wlivestream
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9.2 GFXMixing and Overlays

GFXMixing: Controlled by the ‘GFX Overlay’
window.

GFXPreview: To preview a GFX channel, click the
‘Eye’ icon for the associated channel.

GFXAir: To air a GFX channel, click the ‘Air’ button
for the associated channel.

Link GFX Channels: When selected, both GFX channels will preview or air together.
Cut/Fade Selection: Assigns cut or fade insert method to GFX channels. Fade time is

defined by the ‘Speed’ (in frames) setting in the ‘Main Mix’ window.

10. Media Player Channels

Livestream Studio™ has two built-in Media Player channels. Click the ‘Media 1’ or

‘Media 2’ tab to access the corresponding Media Player module.

Media Editor
ting.mov
/& Show Recording.avi
00201512
Recording August 14 2012...
12

Pre-Show Recording August...
12

Pro-Show Recording August...

C « W »l ] o000:3026

00:00:15;12

Importing Clips: To add a clip to the selected Media Player channel, click the ‘+”
button at the bottom left of the Media Player module and select the locally hosted
file. Add as many clips to a Media Player playlist as desired. Once added, rename

clips by double-clicking on their displayed name within the playlist.

Livestream Studio™ also offers a built-in transcoder. To avoid any further transcoding of
videos, the software requires AVI files with MJPEG Video Codec and uncompressed
PCM audio (48Khz). Livestream Studio™ also supports audio only clips in the form of
MP3, WAV, and AAC files.

For best practice, the video clip resolution and frame rate must match Livestream

Studio™’s user selected Video Format (Preferences > General Preferences > Video

Format).

Wlivestream



30

Transcoder: Livestream Studio™ encodes other video files to the required file
type and specification of the project. When importing a clip that does not match

the project settings, Livestream Studio™ automatically transcodes the file.

STREAM MEDIA2 »

00:00:00;00 ) 00:00:00,00

Transcoding time depends on the length of the clip. Please See Appendix B for all
supported formats. All transcoded files will be stored in the “ My Videos” folder.

(Computer>Local Disk (C:) > Users >”User” >My Videos > Transcoding).

Note: Best practices recommendation: when multiple read/write processes are in play
(Media, GFX, recording), it is recommended that multiple media sources/ destinations

be used. This will improve overall performance of the system.

Removing Clips: To remove a clip from the Media Player playlist, click the ¥
next to the clip name.

Clip Playback Control: To control playbackon a clip, use the playback tools at the
bottom of the clip preview window.

Setting Clip In and Out Points: To set an in or out point on an imported clip,

navigate to the desired timecode and click the ‘In” or ‘Out’ point set button.

'-‘ .
C

) 00:00:30;26

Autoplay: When selected, clips will automatically

play when a transition to the associated Media Autoplay

1 —-—
o
-

Player channel is triggered. Autoplay behavior is
defined by the ‘Media Autoplay Mode Behavior’ setting in general preferences. (See
‘General Preferences’ above). When a clip is 20 seconds or less from its endpoint, the

Media Player preview window will highlight yellow. When a clip is 10 seconds
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or less from its endpoint, the Media Player preview window will highlight red.

Playlist Mode: When selected, the associated media bin will act as a playlist.

Loop Play: When selected, clips or playlists will loop play until the option is

deselected.

Clips recorded locally on Livestream Studio™ are available for immediate use in

Media Players once recordingis terminated.

11. Color Source

Livestream Studio™ comes with two Color Sources that can be used as backgrounds

or as a color test for programs. There is also a tone generator to test sounds.

11.1 Choosing a color

Video Source

To choose a solid color, select the “Solid Color” option.

Click on ‘# symbolto choose the color.

For color bars select the color bars option.

11.2 Test Audio

When using the source color as a test, test audio by selecting the “Test Tone” option.

Audio Source

¥ TestTone

Wlivestream



32

12. Importing video clips into Media Player

To transcode other file types that are incompatible with the built-in transcoder, like
ProRes, convert the media using Adobe Premiere Pro. This process is a good backup,

and also works to transcode on another computer.

12.1 Installing Adobe Premiere Pro

Install Adobe Premiere Pro on either the Livestream Studio™

HD500 or another computer. Dependingon the project, either use the Premiere
Pro 30-day trial (functions without restrictions or watermarks), buy a license for
$799, or get a subscription license via Adobe Creative Cloud for $75/month or
$49/month annually. http://www.adobe.com/products/ creativecloud/buying-

guide.html

e Downloading and installing Adobe Premiere Pro CS6:
1. Download Installer http://www.adobe.com/cfusion/tdrc/index.
cfm?product=premiere_pro

2. Sign in with an Adobe ID or register for free on the website.

¢ Once the download is complete, the installer should automatically launch. Follow

the steps to completeinstallation.

¢ Once Adobe Premiere Pro is installed, install the latest version of the

Blackmagic Design Driver.

Note: if the most updated version of Blackmagic design driver is already installed,

remove it and reinstall the driver.

12.2 Downloading and Installing the Blackmagic Design Driver

Note: Please ensure that Adobe Premiereis installed before performing this step.

e Go to: http://www.blackmagicdesign.com/support
e Download Desktop Video

e If Desktop Video is already installed, remove it, then reinstallthe driver. If

Desktop Video is not installed skip to Step 3.
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¢ Open the Desktop Video file download
1. Once open, select remove all files
2. Selectremove, then follow the steps to complete the uninstall
3. Restart the computer
¢ Installing Desktop Video
1. Open the saved Desktop Video file
2. Follow the steps to complete installation
Note: Windows Security might prompt to verify the publisher:

®

@ Windows can't verify the publisher of this driver software

< Don'tinstall this driver software

You should check your manufacturer's website for updated driver software
for your device.

£ 4

Install this driver software anyway

Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your computer or steal
information.

V) See details

3. Select “Install this driver software anyway.”

4. When the driver completes installation, restart the computer.

12.3 Converting Video Files Using Adobe Premiere Pro

e Open Adobe Premiere Pro and choose a new project:

Recent Projects

New Project Open Project

Help
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¢ Select the capture format:

HDV
©  Blackmagic Capture

e Select the sequence settings.

Important: These should match the Video Formatsetting of the Livestream

Studio™ Project.

Here are two examples:
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e Import the video clip.
1. Go to: File > Import

2. Select the video file and selectopen

The imported file should appear in the clip bin:

0:00 | 42+tir1_h720p.mov
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e Drag the clip into the timeline.

1. The user will be prompted to Change or Keep Sequence Settings.

2. Choose “keep Sequence Settings.”
Clip Mismatch Warning

not match the sequence” . S ce to match the

Change sequen ting settings

e Exporting video clip:

1. Go to File > Export > Media

Edt_Project_Clip Sequence Marker_Tile Window _Help
New »

Open Project. Ctii0
Open Recent Project »
Browse in Adobe Bridge. Cti+AReO

Close Project Cte ShifteW.
Close CtrleW.
Save Ctrtes
Save As... CtitsShift+S.

Save s Copy.. CrleAlt+S.
Revert

Capture..

Batch Capture.
Adobe Dynarmic Link

Adobe Stor

Send to Adobe SpeedGrade...
Import from Media Browser Cti= Alt+1

Import..
Import Recent File

Export . Ctri+M

Get Properties for

Reveal in Adobe Bridge.

Bt

Final Cut Pro XML,
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Select “Match Sequence Settings”

v Summary

Output:

v Video codec

¥ Video settings

00:01:46:35

Enter an output name

¥ Export Settings

v Video codec

v Video settings

Quality

00:01:46:35
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¢ Once exportingthis window will appear:

Encoding

Estimated Time Remaining: 0

See section 10 about addingclips to the media player.

12.4 Downloading and Installing the BlackMagic Design
Driver for Final Cut Pro

Note: Please ensure that Adobe Premiereis installed before performing this step.

1. Go to: http://www.blackmagicdesign.com/support/ and select the product.

Select your product in 3 easy steps

| Host Computer Type |74 Product Series &) Product

_J Linux

Include Legacy
_) Windows XP, Windows Vista, Windows 7

2. Download Desktop Video
3. Installing Desktop Video

1. Open the saved Desktop Video file.

2. Double Click the Installer file to begin installation.
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YeXe) | Desktop Video Installer =) |
1 of 4 selected, 75.9 MB available

0
Install Blackmagic Desktop Video Blackmagicdesign 8

b

Desktop Video Installer
9.6.8

Test Clips Product Manuals

Uninstall Desktop Video

4. Follow the steps to complete installation.

5. When the driver completes installation, restart the computer.

12.5 Converting Video Files using Final Cut Pro 7

1. Open Final Cut Pro and choose a new project
2. Drag the video clip into the file bin
3. Drag the clip into the timeline
1.A prompt to Change the Sequence Settings will display.
2. Choose “Yes”
4. Go to File > Export > Quicktime Movie
5. Choose sequence settings
Note: Settings must be exactly the same as the settings on the Livestream Studio™ project.

6. Save the clip

See section 10 about adding clips to the media player.
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Appendix

Appendix A- Supported Devices

PCle Capture and Playback

e Blackmagic Design® DeckLink Quad™

¢ Blackmagic Design® DeckLink SDI™

¢ Blackmagic Design® DeckLink Duo™

¢ Blackmagic Design® DeckLink Optical Fiber™

¢ Blackmagic Design® DeckLink Studio™

¢ Blackmagic Design® Intensity Pro™

e Blackmagic Design® DeckLink HD Extreme 3D™

e Blackmagic Design® DeckLink 4K Extreme™

uUsB 3.0

¢ Blackmagic Design® UltraStudio Pro™

e Blackmagic Design® UltraStudio SDI™

¢ Blackmagic Design® Intensity Shuttle™ for USB 3.0

e Blackmagic Design® ATEM 1 M/E Production Switcher™
e Blackmagic Design® ATEM 2 M/E Production Switcher™

Thunderbolt

e Blackmagic Design® Intensity Shuttle™ for Thunderbolt™ http://www.
blackmagicdesign.com/products/intensity/

e Blackmagic Design® Intensity Extreme™ http://www.blackmagicdesign.
com/products/intensity/

e Blackmagic Design® UltraStudio Express™ http://www.blackmagicdesign.
com/products/ultrastudio/

e Blackmagic Design® UltraStudio Mini Recorder™ and Mini Monitor™

http://www.blackmagicdesign.com/products/ultrastudio/
Tally Lights

* The Livestream Studio™ software currently supports Tally Light devices from metaSETZ

(www.metasetz.com).
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Appendix B - Supported Formats for
Transcoding

File Containers

Format File Extensions Media Media Requires
Source Sink
3GP .3g2, .3gp, MPEG-4 3GP File Windows 7
.3gp2, .3gpp File Sink
Advanced .asf, .wma, ASF Media | ASF Media | Windows
Streaming .wmv Source Sink Vista
Format (ASF)
Audio Data .aac, .adts ADTS File None Windows 7
Transport Source
Stream
(ADTS).
AVI .avi AVI File None Windows 7
Source
MP3 .mp3 MP3 File MP3 File File
Source Sink source:
Windows
Vista
File sink:
MPEG-4 .m4a, .m4v, MPEG-4 MPEG-4 Windows 7
.mov, .mp4 File File
Synchronized .sami, .smi SAMI Media] None Windows
Accessible Source Vista
Media
Interchange
(SAMI)
WAVE .wav AVI File None Windows 7
Source
Audio Codecs
Format Decoder Encoder| Requires
u-law Coding Audio Compression None Windows Vista
Manager (ACM) p-law
Codec
Adaptive Differential ACM ADPCM Codec None Windows Vista
Pulse Code
Modulation (ADPCM)
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Advanced AAC Decoder AAC Encoder Windows 7
Audio
MP3 Windows Media None Windows Vista
MP3 Decoder
GSM 6.10 ACM GSM 6.10 None Windows Vista
Codec
Windows Windows Media Windows Windows Vista
Media Audio Decoder Media Audio
Audio (WMA) | Windows Media Decoder
Audio Voice Windows
Decoder Media Audio

Note: Media Foundation provides wrappers for several ACM codecs, listed in the

previous table. However, Media Foundation does not support arbitrary ACM codecs.

Video Codecs

Format Decoder Encoder Requires
DV Video DV Video De- None Windows 7
coder
H.264 H.264 Video H.264 Video Windows 7
Decoder Encoder
MJPEG MIJPEG Decoder None Windows 7
MPEG-4 Part 2 | MPEG-4 Part 2 None Windows 7
Video Decoder
MPEG-4 Windows Media None Windows Vista
vl/v2/v3 MPEG-4 V3
Decoder Windows
Media MPEG4 V1/V2
Decoder
Windows Windows Media Windows Media Windows Vista
Media Video 9 Decoder Video 9 Encoder
Video (WMV) | Windows Media Windows Media
Video 9 Screen Video 9 Screen
Decoder Encoder
Windows Media
Video 7/8 En-
coder

“Supported Media Formats in Media Foundation (Windows).” Supported Media Formats in
Media Foundation (Windows). Microsoft, 28 Nov. 2012. Web. 7 Feb. 2013. <http://msdn.

microsoft.com/en-us/library/windows/desktop/dd757927%28v=vs.85%29.aspx>.
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Appendix C - Input Source Troubleshooting

If there is no video signal in the Livestream Studio™ Software please make sure to confirm

the following:

Are you using a Blackmagic capture device?
The Livestream Studio™ Software only accepts video signals from certified Blackmagic
capture devices. If using a non-Blackmagic device there is a chance the signal will not

appear in the software.

Do you have the latest version of the Blackmagic drivers?
Stock drivers are often out of date as Blackmagicfrequently releases updates. Please be
sure the latest version of the Blackmagic drivers are installed, which can be downloaded

from http://www.blackmagicdesign.com/support

e Select the Operating System (Windows) in Step 1

e Select the device Series (Decklink, Intensity, etc) in Step 2

e Select the Product in Step 3

e Click Search

¢ Download the latest ‘Desktop Video’ for Windows and run the file

Are you getting a video signal in Blackmagic Media Express?

Click the ‘Start’ button, search for Media Express, and click Blackmagic Media Express to
open the program. Select the ‘Log and Capture’ tab to display the video input. Click Edit on
the menu bar at the top of the program and select ‘Preferences,” then confirm that the
Project Video Format matches the format of the video source. If a video signal is present in
Media Express, check Livestream Studio™’s video format settings. Ifa video signal is not
present in Media Express, confirm a connection to the correct input and that the camera is

configured properly.

Does Livestream Studio™’s video format match yourinput source?

Open Studio’s Preferences by clicking the “Gear Wheel” icon at the top right- hand side of
the program window. Click the ‘General’ tab at the left-hand side of the ‘Preferences’
window, and choose the video format that matches the input source’s format. Please

note that all input sources should match Livestream Studio™’s video format setting.

Are you connected to the correct inputof your Blackmagic device?
Generally Blackmagic does not specifically mark the input/outputs of the device on the
actual hardware. Please check the capture device’s documentation to confirm the

proper input.
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Is your camera configured properly?
Many cameras with multiple output formats allow the user to define a specific output
method. Check the camera’s settings to confirm they are properly configured for HD-

SDI, HDMI, or analog depending on the input to the Blackmagic device.

Doesyour camera output to an external display?
Connect the camera’soutput to an external display such as a monitor to verify the video
signal. If a signal is not received, try a new wire of the same type or double-check the

camera’s settings.

Appendix D - Known Issues

Audio on SDI output

Updating the Blackmagic drivers may resultin an echo on the audio output when
sending the program feed via SDI. This is due to a configuration change within the Sound
setting in the Windows control panel. To resolve, open the ‘Sound’ section of the
Control Panel (Control Panel > Hardware and Sound > Sound) and disable all Blackmagic

Audio outputs.

Input Source Conversion
When using a 1080i source within a project that is set to any other video format, some
distortion or interlacing on the resulting preview may occur due to improper

identification of the input source as Progressive. To avoid this issue:

e Change the Video Format of the project withinthe ‘General’section of the ‘Preferences

Menu.’

e Within the Input Settings > Convert, manually select 1080i as the input format.
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Warranty

Livestream provides a limited one (1) year warranty for Livestream Studio™. The
limited warranty covers defects in components and workmanship as well as
functionality of the Livestream Studio™ Software. The warranty start date begins on

the day the item is shipped.

The limited warranty does not cover the following:
e Software, including the operating system and any third party software
e Failure due to viruses, bugs, or any type of malicious software
e Hardware or components not includedin the original assembly
e Externalcomputer hardware products and peripherals

e Problemsthat result from:
1. Accident, abuse, or misuse
2. Servicing not authorized by Livestream
3. Usage that is not in accordance with product instructions
4. Failure to follow the product instructionsor failure to perform preventive
maintenance
5. Failure to follow Livestream’stechnical support or RMA instructions including

improper packaging

e Productthat has been damaged by actionsthat are beyond Livestream’s
control, including for example, impacts, fluids, fire, flood, wind, earthquake,
lightning or similar disaster, war, strike, lockout, epidemic, destruction of

production facilities, riot, insurrection, or material unavailability

Livestream will replace or repair any component or system free of charge.
Livestream will ship free of charge any item covered by warranty back to the
customer in the continental United States via ground delivery. Any other shipping
fees will be covered by the customer. Customer must insure both ways ifinsurance
is desired. Livestream does not insure RMA shipments. To request an RMA, go to

help.livestream.com and fill out a support claim.

Livestream Studio™ Dongle Policy

Lost or stolen dongles are your responsibility. The only way to replace a dongle is to
buy another one. Ifyou think your dongle is broken or malfunctioning you can

contact support at support@livestream.com to request an RMA.

Livestream Store Return Policy
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All returns must be shipped with an RMA (Returned Merchandise Authorization)
number visibly printed on the outside of the return packaging. Any product returned
without an RMA number will be returned to the customer. To request an RMA e-mail

rma@livestream.com. Returns may be assessed a restocking fee as described
below.

Livestream reserves the right to reject any RMA or refund request for a damaged unit
or unit returned with missing parts.
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